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ability to edit multiple files at the same time.
This is a highly requested feature for the SAS
System.

ABSTRACT


The Nashville Release of the SAS System for Windows
provides support for Windows 95, Windows 98, and
Windows NT 4.0. With this version, the SAS System
continues to improve in the areas of user interface, application integration, and setup. This paper discusses
both new features and enhancements in these areas.
Additionally, this paper also discusses the support provided by the SAS System for Windows NT.

INTRODUCTION
This paper provides an overview of the Nashville Release. You should view this paper as an introduction but
should refer to the SAS documentation for more details.
Additionally, refer to “Introducing Release 6.12 of the
SAS System for Personal Computers” for a summary of
enhancements added in Release 6.12. The Nashville
Release continues to provide incremental enhancements
to the user interface of the SAS System. In order to create a Windows application that best utilizes the Windows
feature set, we follow the GUI standards documented in
The Windows Interface Guidelines for Software Design.

GUI FEATURES
GUI enhancements in the SAS System Nashville Release continue the trend to provide a more native look
and feel familiar to PC users. Some of the GUI features
include a new editor, a print preview utility, additional
printing options, Application Workspace (AWS) enhancements, and Microsoft IntelliMouse support.
ENHANCED EDITOR
An enhanced editor is new in Version 8 of the SAS System. This editor is only available on the Windows platform. The editor’s many features should make it an attractive alternative to the existing Program Editor.
A key feature of the enhanced editor is color coding and
syntax checking of SAS programs. This capability allows
you to more easily detect coding errors such as
unmatched quotes.
Another important benefit of the enhanced editor is the

PRINT PREVIEW
To see how the contents of a window will appear
as printed output, select the window you want to
preview and then select Print Preview from
the File menu (or click the Print Preview
tool bar button).
In the Print Preview window, you can use the
Next and Previous buttons to navigate
through the pages to be printed. The current
page number and total number of pages are
displayed at the bottom of the window. You can
also magnify your view of the current page (by
100%) by clicking Zoom, or by simply clicking
inside of the page. To reduce your view, click
Zoom or inside of the page again.
In the Print Preview window, you can navigate by
using the following shortcut keys:
Key
PgDn
PgUp
Ctrl-PgDn
Ctrl-PgUp
Ctrl-Home
Ctrl-End

Full-Page mode action
Advance to next page
Back to previous page
none
none
Go to first page
Go to last page

Zoom mode action
Scroll down on current page
Scroll up on current page
Scroll right on current page
Scroll left on current page
Go to first page
Go to last page

The command, DLGPRTPREVIEW, can be used
to invoke the Print Preview window.
PRINTING OPTIONS
The SYSPRINT option and FILENAME statement
have been modified to be more consistent with
how printers are identified today on PCs. Port
names are no longer required. Instead, the
printers are now identified using the printer name
as recognized by the operating system.
Continued support for the Release 6.12 format is
provided as much as possible. The Release 6.12
syntax and the new Nashville Release syntax are
shown below.
Release 6.12
Options sysprint=”port”
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“[print mgr print name]”
Filename x printer “port”;
Nashville Release
Options sysprint=”printer name”
“[print–to-file filename]”;
Filename x printer “printer name”;
More improvements to printing include the addition of
new options to provide programmatic control of settings
previously available only in interactive dialogs. Below is
a list of the new options:
ORIENTATION
Specifies orientation of printed output on
paper
LEFTMARGIN
Specifies left margin for printed output
RIGHTMARGIN
Specifies right margin for printed output
TOPMARGIN
Specifies top margin for printed output
BOTTOMMARGIN
Specifies bottom margin for printed output
PAPERSIZE
Specifies size of paper used for printing
PAPERSOURCE
Specifies bin to use paper from
DUPLEX
Controls whether and how printed output is
duplexed
COPIES
Specifies number of copies to print
Another improvement to printing is the addition of a Page
Setup dialog from which you can interactively change
orientation, margins, paper size, and paper source. This
new dialog replaces the functionality for setting orientation and margins that was previously accessible from the
Print Setup dialog. An important aspect of this change is
that there is now one global setting for orientation and
margins, rather than a different setting for each printer.
This makes the SAS System more consistent with other
Windows applications, in which orientation and margin
settings are normally independent of the currently selected printer. The Page Setup dialog can be invoked by
selecting Page Setup from the File menu, by clicking
the Page Setup button on the Print Setup dialog, or by
issuing the DLGPAGESETUP command.
AWS ENHANCEMENTS
Several enhancements to the AWS, the main SAS System window, have been added in this release. These
include changes to the toolbar and command bar, the
addition of a WindowBar, and the addition of Docking
View. Below is a snapshot of the initial SAS System environment.

The SAS System uses industry standard tools on
the default toolbar. The Customize dialog
provides a way for you to create custom
toolbars. In this version the toolbar uses the flat
style to be more consistent with other Windows
applications.
The SAS System supports a command bar for
easy entry of commands. In previous releases of
the SAS System, commands were not preserved
when exiting the SAS System. In the Nashville
Release commands entered via the command
bar are saved when exiting. The number of
commands saved is configurable in the
Preferences dialog. With the Preferences dialog
you can also select whether to order the
commands by most recently used.
Another new command bar feature is
AutoComplete. With AutoComplete enabled the
SAS System attempts to match characters as
they are typed in the command bar with
previously entered commands. If a match is
found, the command will be completed in the
command bar for you with the added portion of
the command selected. You may press enter to
execute this command or continue typing to
finish your command. AutoComplete may be
disabled in the Preferences dialog.
An additional enhancement to the toolbar and
the command bar is support for resizing them.
Many users have requested the ability to have a
larger command bar area.
The WindowBar is a new addition in the
Nashville Release and is an alternative to the
window list. The WindowBar allows quick and
easy access to the current set of windows in use
in the SAS System. To disable the WindowBar
use Preferences or use the WWINDOWBAR
command.
The Docking View occupies an area on the left
side of the AWS. If a SAS System window
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displays in the Docking View, it is considered docked.
Windows that are used for navigating, such as the
Explorer and Results windows, typically display here.
Double-clicking an item in a docked window displays the
new window to the right of the Docking View. The
docking view area can be resized by clicking on the
splitter that separates the docking view from the other
SAS System windows. Docking view can be disabled in
Preferences or by using the WDOCKVIEW command.
A new option, WEBUI, is available in Version 8 of the
SAS System. This support is relevant for users who have
Microsoft Internet Explorer 4.0 or greater. If you have
Web style Desktop selected in the Internet Explorer
options, you may prefer to use the same configuration in
the SAS System. The SAS Explorer is one example in
which you will notice the effects of this option.
PROGRAM EDITOR ENHANCEMENTS
The Program Editor continues to be enhanced to provide
more native Windows editing capabilities. Some enhancements in this version include improved selection
and AutoSave support.
Here is a list of changes related to text selection:
•

Use the CTRL-DELETE key to delete the current
word instead of the whole line.

•

Use the ALT key as you hold down the mouse button
and drag the mouse to select a rectangular block (or
column) of text.

•

Use the SHIFT key in combination with the mouse
button to extend the selection of a text area. (You
can use this feature only within the current page.)

•

When copying text to the clipboard, the text stays
selected in the SAS system after the copy has occurred.

•

When pasting text into the SAS system when an
area is marked, the marked text is replaced with the
new text.

AutoSave support is now available in the editor windows
in the SAS System. AutoSave works in the Program
Editor Window and in the new Enhanced Editor windows.
The default interval for saving the contents of an editor
window is 10 minutes. The interval is configurable in the
Preferences dialog.
INTELLIMOUSE
The SAS System provides support for the Microsoft
IntelliMouse. The IntelliMouse is a modified mouse that
includes a rotating wheel (wheel control) that enables

new forms of navigation. The IntelliMouse is
supported in windows within the SAS System
that use a vertical scrollbar for scrolling the
window contents.
The IntelliMouse provides an alternative
mechanism for scrolling. With the IntelliMouse
you can now use your mouse to scroll instead of
interacting with the navigation controls on the
screen. To scroll with the IntelliMouse, you rotate
the wheel control forward or backward, which is
equivalent to pressing the up arrow or down
arrow on the scrollbar.
The IntelliMouse also supports AutoScroll. To
initiate AutoScroll click the mouse wheel, then
move the mouse away from the origination point.
The contents of the window will start to scroll in
the direction you move the mouse. The farther
away you move the mouse from the origination
point, the faster the contents will scroll. Pressing
a key, clicking a mouse button, or rotating the
mouse wheel will terminate AutoScroll mode.
You can modify settings for the IntelliMouse
through the Control Panel mouse settings. See
the
Microsoft
documentation
for
more
information about the IntelliMouse.
RICH TEXT FORMAT SUPPORT
The SAS System provides two TrueType fixed
pitch fonts: SAS Monospace and SAS
Monospace Bold. These fonts contain several
extended ASCII line drawing characters in
positions that are normally undefined in an ANSI
font. Using these line drawing characters with
the TABULATE procedure provides a smooth
line drawing capability resulting in tabular output
that is more visually appealing.
You can use the Save As dialog to create RTF
files containing the content of text windows. The
command, WRTFSAVE, saves the contents of the
current text window to an RTF file.
HTML SUPPORT
With the Nashville Release the SAS System can
also generate output in HTML format. Please
refer to the paper "ODS for Data Analysis Output
As-You-Like it in Version 7" for more information
about how to accomplish this with the SAS
System. You should also see the following
section on Preferences for available settings
within the SAS system.
PREFERENCES
Additional preference settings have been added
to give users more control of the SAS System
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environment. The Preferences dialog has also been
updated to use a tabbed dialog to categorize settings.
See the Preferences snapshot below with the Results
Tab selected.

The Results Tab lets you select a results format of
HTML, Listing, or both. If you enable HTML format, you
can select what style to apply to the generated output
and where to place the resulting HTML files. You can
also choose whether you want your HTML results displayed in an internal browser or in your preferred web
browser. You need Microsoft Internet Explorer 3.02 or
higher installed on your machine to display results in the
internal browser. Selecting to use the preferred web
browser would enable the display of HTML in the
browser configured on the Web Tab in Preferences. If
AutoNavigate is enabled, results will be progressively
displayed in the configured browser as HTML is
generated.
More new preference settings are listed below:

Hide cursor in non-input windows
This setting suppresses the display of the cursor in SAS
windows that do not allow text input.
Disable scrollbar focus
This setting prevents scrollbars that exist internal to the
window dressing from getting focus. This prevents the
flashing thumb bar that sometimes occurs in windows
that use scrollbars in this way.
Save settings on exit
Enabling this option causes the saving of window placement settings when you exit the SAS System.
OPEN AND SAVE AS DIALOGS
In previous releases of the SAS System filetypes and
filenames for the Open and Save As dialogs were associated with the dialog instead of the active window. With
this version filetypes and filenames are associated with
the window that invokes the dialog. These changes allow
the window that invokes the dialog to set the default file-

type and filename.
The DLGOPEN command has been enhanced to
extend support for long filenames. The previous
format of the command did not support complex
filters. Complex filters include filters with spaces
and apostrophes. The enhanced syntax is:
DLGOPEN longfilter =
“a b.sas|b’s.sas”.
MENU CHANGES
The menus in the Nashville Release have been
redesigned to be more compatible with Microsoft
Office applications. The most obvious change is
the removal of the Options menu item and the
addition of the Tools menu item. Most items
from the Options menu now exist on the
Tools menu. Below is a picture of the new
Tools menu.
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IMPROVED HELP
The SAS System help facility uses HTML help for this
release. Some of the documentation available in this
format includes usage notes, the SAS sample programs,
the Windows companion, and the SAS System requirements.
FONT SCRIPTING
The capability to specify the script (codepage) to be used
with a font is a new feature in the Nashville Release.
This feature allows you to use fonts that have codepages
other than the default codepage currently in use by the
SAS System. This feature is useful for international
users of the SAS System or users that use more than
one character set at a time. For example, users can now

create SAS/AF FRAME entries that use a Cyrllic, Greek,
and Western European font at the same time.
OLE/ACTIVEX
OLE 2.0, which the SAS System has supported since
Release 6.10, provides many features that you can use

to enhance your SAS/AF FRAME entries and SAS/EIS
applications. The SAS System OLE support consists of
OLE container (including support for ActiveX controls),
OLE automation controller, and OLE automation server.
For a more in-depth description of the OLE support
available in the SAS System, refer to the paper “OLE and
the SAS System for Windows Release 6.12”.
To enhance our support of OLE we have added the ability to automate an OLE server on a remote machine using DCOM (distributed common object model). With this
functionality you could access Microsoft Excel data that
exists on someone else’s machine and use it within your
SAS/AF PROGRAM.
To use DCOM you must run the dcomcnfg utility on the
remote machine to set up permissions to run applications. Please refer to the DCOM help topic available with
the Windows System for more information.

APPLICATION INTEGRATION
The Nashville Release of the SAS System continues the
evolution of the SAS System’s integration with other applications. In addition to communications possible with
pipes, DDE, Lotus Notes interface, and external DLL access, support for communication through e-mail is also
possible.
Communication to applications such as Lotus Notes Mail
or e-mail packages is handled through MAPI support in
the SAS System. As long as basic mail services are
installed, the SAS System will use the MAPI client interface to allow postings to packages like Microsoft Ex-

change Server and Lotus Notes Mail. Since
each of these client packages (starting with
Notes Release 5) support connectivity with
SMTP (Simple Mail Transfer Protocol), the SAS
System can also post mail to SMTP/POP3-style
internet mail systems by utilizing these client
packages. In addition, if an administrator has
set up routing for specific mail recipient
identifiers to locations such as public folders, the
SAS System can be used to direct mail directly
into Microsoft Exchange Server public folders for
collaborative data viewing.

UNIVERSAL ODBC DRIVER
The Universal ODBC Driver allows other
applications to access SAS data without
requiring availability of the SAS System. This
driver is new since Version 6 and supplements
the basic SAS ODBC Driver that provides ODBC
data access through the Base SAS System.
While the SAS ODBC Driver provided both read
and write access to data through the SAS
System, the Universal driver provides read-only
access.
This driver is significant because it allows other
applications, such as Microsoft Excel, to directly
access data stored in SAS formats without
requiring the SAS application software. For
organizations storing large amounts of SAS data
on PC networks, this driver opens up the server
data to more applications than ever before.
The Universal ODBC Driver is sold separately
and operates only on Windows platforms. The
driver provides access to the standard data
sources, including: SAS data sets, Version 6
CFO Vision Financial Database (FDB) files,
Version 6 SAS multi-dimensional database
(MDDB) files, and JMP files. New for Version 8,
the Universal ODBC Driver also provides access
to SAS Transport Files, so that data from any
SAS platform can be accessed by remote
applications. For direct, native access, the
Universal ODBC Driver also supports access to
Version 6 SAS data generated on other platforms, such as UNIX or OpenVMS directly.
You can download an evaluation copy of the
Universal ODBC Driver from the SAS Institute
web site (http://www.sas.com), following the links
to Demos/Downloads, ODBC Drivers, and SAS
Universal ODBC Driver. This driver is also
available for purchase at the same web location.
Note that this driver is a single-time purchase
item that will continue to be useful without
renewal or other fees in the future. However,
upgrades are not included in the base purchase
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price.
SAS ODBC DRIVER
The SAS ODBC Driver has also been enhanced in the
Nashville release to improve reliability and performance.
This Driver requires the presence of the SAS System on
either the local PC or it can use TCP/IP to access a remote SAS System on another PC or any other system on
which the SAS System is located. This driver provides
read/write access to data on the remote SAS System.
Both this driver and the Universal ODBC Driver can
function well in web-based environments in which serverside processing is used and the driver is available on the
web server. For this type of use, the drivers have been
made more robust to support higher levels of concurrent
access and user load.
Although the SAS ODBC Driver is included with a purchase of the Base SAS System, you can also download
the latest version of the SAS ODBC Driver for use on any
Windows PC to be used with SAS System servers on
any platform. The download is available from the same
location from which the Universal ODBC Driver is
available (under http://www.sas.com, following links to
Demos/Downloads, ODBC Driver, and the SAS ODBC
Driver).

SAS Transport File Support
The SAS System Viewer supports collaborative
viewing of data generated on any platform on
which the SAS System operates through the
ability to read files stored in the SAS Transport
File format. This format is publicly documented
and has remained consistent since Version 5 of
the SAS System. Files of this type typically use
the extension .XPT or .STX (consistent with their
use in the SAS JMP product) and are recognized
by the Version 8 SAS System Viewer.
HTML output Viewing Support
Since the Nashville Release of the SAS System
supports the generation of output in HTML for
web-based use, the Viewer also supports
viewing this output as well. If you are using
Microsoft Internet Explorer 4.0 or greater, the
Viewer will allow you to browse SAS HTML
output as well as other SAS filetypes in a
consistent manner.
You can download the free SAS System Viewer
from
the
SAS
Institute
web
site
(http://www.sas.com), following the links to
Demos/Downloads, Base SAS Software, and the
desired version of the SAS System Viewer.

SAS SYSTEM VIEWER
The free SAS System Viewer has been enhanced to accompany the Nashville Release of the SAS System. In
addition to supporting data formats from Version 6
through Version 8 (excluding SAS catalogs, FDB, and
MDDB files past Version 6), it has enhancements in several areas.

SETUP ENHANCEMENTS

Improved Printing Support
The Viewer now handles pagination embedded in SAS
System monospace output files. When these types of
files are browsed, they can be correctly viewed and
printed. For consistency with the SAS System, the SAS
Monospace font is included with the Viewer and used by
default.

Multiple user support
To facilitate multiple users on the same
computer, Setup defaults to allow users to use
separate SASUSER and SASWORK locations.
By placing these folders in locations separate
from the main SAS System image, network
installations can be more easily shared, and NT
users can avoid conflict between users of the
SASUSER folder. By default, Setup will use the
system settings for the main system TEMP
directory for the base location of SASWORK
temporary files. Setup also uses a default of the
user’s USERPROFILE (on Windows NT and
Windows 2000) or location of “My Documents”
(on Windows 95 and 98) as a base location for
SASUSER user-specific files.

Workbook View Support
When viewing multiple windows simultaneously, the
Viewer allows the selection of a tabbed workbook view to
facilitate navigation.
Data Subsetting Support
To facilitate the viewing of very large SAS data sets, the
Viewer can be configured to subset the number of observations being viewed. This allows much larger data
files to be viewed without exhausting system memory.
The Viewer supports a maximum display of 65,536 rows
of data at a time, equivalent to the limit of Microsoft
Excel. More data can be viewed by paging through subsets of data.

The basic operation of the SAS System Setup
program has been enhanced in a number of
areas.

Another benefit of this configuration is that
automated utilities (such as the Disk Cleanup
utility in Windows 98) will look in this location for
files that can remain after an abnormal
shutdown. In conjunction with these utilities,
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SAS System temporary files can be easily cleaned up
along with files from other standard applications.
Use with Roaming User Profiles
As site administrators migrate to Roaming User Profiles,
the default configuration suggested by the SAS System
Setup program will support them. Roaming Profiles are
user areas that are stored on a fileserver and copied to
the local system when the user logs in on a client system. If the user travels or uses a variety of systems, this
ensures that the user’s settings and documents travel
with them to each new system. By virtue of the SAS
System use of standard USERPROFILE settings for
SASUSER files, SAS System settings also travel with
them as the user logs in to a new, remote system.
Use with Microsoft Terminal Server
Terminal Server is a special version of Windows NT 4.0
that allows multiple users to log in to a single NT system
remotely and see their user display on a remote monitor.
Defaults used in the SAS System Setup program support
this operation. Again, since USERPROFILE settings are
used, specific user directory locations are used, and the
multi-user security enforced by Terminal Server works
with the SAS System. In addition, since multiple users
have separate and protected TEMP directories,
SASWORK directories are also protected on multi-user
systems and avoid multi-user conflict situations.
Multiple installation support
Setup now handles separate invocations, and a single
uninstall will correctly remove all previously installed SAS
System files.
New dialog selections
In response to user suggestions, the Setup dialogs have
been reorganized so that Personal, Client, and Server
installations can be more easily selected and performed.
In addition, Server installations are more configurable in
the Version 8 Setup application to take administrative
privilege requirements and other server-related requirements into account.
Please refer to the paper, “Taking Advantage of the SAS
System on Windows NT” (also in these Proceedings) for
more details on NT-specific features available in the
Nashville Release of the SAS System.

OPERATION ON WINDOWS NT
In addition to indirectly benefiting from Windows NT-specific features, such as the 64-bit capabilities of NTFS and
SMP (symmetric multi-processing) support, the Nashville
Release of the SAS System takes advantage of several
other capabilities on the Windows NT platform.

NT-specific performance enhancements
The SAS System takes advantage of NT
features that improve the performance of input
and output on the NT platform. These include
optimizations for both sequential and random
I/O, and are most beneficial when operating on
large amounts of data stored on Windows NT
Server. In addition, various algorithms have
been re-coded to maximize their performance on
high-end computer hardware.
Scatter/Gather I/O
For large data processing requirements, this
type of operation has been added to Windows
NT (starting with NT 4 Service Pack 3). The
SAS System can take advantage of this
advanced form of I/O for greater throughput
performance for certain types of operations.
Support for Very Large Memory on Advanced
Processors
With the availability of the Pentium II Xeon
processor, Intel-based servers gained the ability
to access memory beyond the four gigabyte
boundary. Using an architecture called ESMA
(Extended Server Memory Architecture), an
application can utilize this memory for very largescale tasks. ESMA requires a driver available
from Intel Corporation, and provides access to 8
to 32 gigabytes of RAM.
The SAS System Version 8 takes advantage of
ESMA as either a very large disk cache or inmemory library. When ESMA is utilized
effectively, the speed of input/output operations
can be greatly improved since the SAS System
doesn’t have to wait for a relatively slow
(compared with RAM) disk drive system to
respond to data requests.
When in use,
Windows NT memory and disk caching
algorithms are bypassed, leaving them able to
respond to smaller requests more effectively. In
the ideal case of utilization of ESMA, the amount
of real, elapsed time required to accomplish a
processing task approaches the CPU time,
which is typically far smaller when large amounts
of data are involved.
NT monitoring tools
The SAS System takes advantage of Windows
NT system utilities, such as Performance
Monitor and Event Log, for more accurate
diagnostics and monitoring when deployed in a
distributed server environment.
SAS Configuration file customizability
Features of the Nashville release allow a system
administrator to specify a grouping of SAS
System configuration files (formerly called
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CONFIG.SAS, now called SASV7.CFG or SASV8.CFG)
to be arranged to meet enterprise deployment needs.
Configuration files can be nested (including one another)
so that standard settings can be used for a wide-scale
use, and user-specific overrides or additions can
supplement the standard configuration.
Microsoft System Management Server (SMS) Support
The Nashville Release of the SAS System takes advantage of SMS to provide remote, unattended installation of
the SAS System. For organizations utilizing SMS, this
greatly facilitates the distribution of software during installation time, as well as for updates.
Please refer to the paper, “Taking Advantage of the SAS
System on Windows NT” (also in these Proceedings) for
more details on NT-specific features available in the
Nashville Release of the SAS System.

CONCLUSIONS
This paper summarized some of the many features
available in the Nashville Release of the SAS System.
Enhancements in the user interface, Windows integration, and setup program areas continue to move the SAS
System into the future. Taking advantage of the capabilities of Windows NT is just another way in which we are
trying to deliver a solid Windows application.
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